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1 About This Document
1.1 General

This document describes every parameters of the gateway PD-100S and provides using methods and some

announcements that help users use the gateway. Please read this document before using the gateway.

1.2 Copyright Information
Copyright of this document reserved. SiboTech maybe upgrades the product without notifying users.

is the registered trade mark of SiboTech Automation Co., Ltd.

1.3 Terms
DeviceNet: DeviceNet Protocol, accord with DeviceNet Protocol Release 2.0

PROFIBUS-DP: PROFIBUS-DP Protocol
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2 About the Gateway
2.1 Product Function

PD-100S exchanges data between DeviceNet and PROFIBUS-DP. It can connect a master device with

DeviceNet interface to PROFIBUS-DP master.

Note: The order number is PD-100S when DeviceNet port acts as a slave, and the order number is PD-100 when

DeviceNet port acts as a master.

2.2 Feature
▼Widely Used: Achieve the direct connection between DeviceNet network and PROFIBUS-DP network. Such as:

Establish the communication between Rockwell, Omron PLC and Siemens S7 PLC.

▼Easy Implementation: Referring to the manual and the examples provided, users can establish the connection

quickly.

▼Transparent Communication：User can accord the mapping relationship between PROFIBUS communication

data area and DeviceNet communication data area to achieve the transparent communication between PROFIBUS and

DeviceNet.

2.3 Technical Specification
[1] PROFIBUS DP/V0 slave; Follow EN50170 and JB/T 10308.3-2001: The chapter 3 of measurement and

control of digital data communications Industrial Control System: PROFIBUS standard;

[2] Up to 224 bytes input and 224 bytes output, user can also select 32, 96, 48, 112, 72, 160, 192 bytes;

[3] PROFIBUS-DP interface and DeviceNet interface have independent 2.5KVphotoelectric isolation;

[4] Act as a slave at the side of DeviceNet, and support Poll I/O;

[5] DeviceNet baudrate: 125K, 250K, 500Kbps and Auto baudrate;

[6] Supply many LED status lights indicating network status;

[7] Power: DC 11-26V; 4W@24V;

[8] Operating temperature: -40 ~ 60 ℃; Humidity: 5 to 95% (No Condensing);

[9]Mechanical Dimension: 125mm (H) × 40mm (W) × 110mm (D);

[10] Installation: 35mm rail;

[11] Protection Level: IP20;
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2.4 Attention

 To prevent stress, prevent module panel damage;

 To prevent bump, module may damage internal components;

 Power supply voltage control in the prospectus, within the scope of the requirements to burn module;

 To prevent water, water module will affect the normal work;

 Please check the wiring, before any wrong or short circuit.

2.5 Related Product
Other related products in SiboTech:

PD-100 and so on.

If you want to gain some products’ instructions above, please visit our website http://www.sibotech.net/en , or

call technical support hot line: +86-21-5102-8348.

3 Hardware Description
3.1 Product Appearance

PROFIBUS-DP
Interface

DIP Switch: Set
DeviceNet address
and baudrate

Rotary Switch: Set
PROFIBUS-DP
address

LED IndicatorsPower Interface

RS232 LED: Display
network status and
address

DeviceNet Interface

http://www.sibotech.net/en
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3.2 Indicators

DeviceNet Module Status Indicator (MS)

Status Description
Off Without power supply or indicator may be bad
Always Green Work properly
Green Blinking Incorrect configuration, or in baud rate interception

status

Red Blinking Recoverable fault
Always Red Unrecoverable fault
Red – Green Blinking Self testing

DeviceNet network status indicator (NS)

Status Description

Off DeviceNet without power
Green Blinking Device is online, but not connection
Always Green Device is online and there is a connection

Red Blinking One or more connection timeout
Always Red Device detects an unrecoverable fault, and can not

communicate, For example, DeviceNet address repeat

RS232 interface indicator (SE)

Status Description

TX Off Serial has no data sent
TX Red Blinking Serial is sending data
RX Off Serial has no data received

RX Green Blinking Serial is receiving data

PROFIBUS-DP network status indicator (PB)
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Status Description
PBF Off Communication is OK

PBF Always Red PROFIBUS-DP communication fails
STA Off PROFIBUS-DP is not communicating

STA Green Blinking PROFIBUS-DP is communicating

3.3 Configuration Switch
Setting switch of PROFIBUS-DP address:

PROFIBUS-DP address is calculated as:

PROFIBUS-DPAddress=（A×10）+（B×1）

Description of DIP switch being used setting DeviceNet address and baud rate :

3-8 bits switches are the DeviceNet address setting switches, and they correspond with DeviceNet address #1bit -

# 6bit. They use binary coding (On is 1,Off is 0).

1 and 2 bits are used setting DeviceNet baudrate:

0
2

×10 ×1

A B
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3.4 LED
The main contents of LED include: DeviceNet address and PROFIBUS-DP address. After power on, LED

successively display "pb", the current PROFIBUS-DP address, "dn" and the current DeviceNet address.

3.5 Interface

3.5.1 DeviceNet Interface Wiring Instructions

5-pin connector at the side of DeviceNet:

V+GND CAN_L

SHIELD

CAN_H

1 5

 1-pin GND

 2-pin CAN_L

 3-pin Shield

 4-pin CAN_H

 5-pin +24V
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Note: V+, GND of DeviceNet interface interlinks V+, GND of power interface. So an external power supply

only one interface can be connect, can not simultaneously connected to the two interface power supply.

3.5.2 PROFIBUS-DP Interface

PROFIBUS-DP wiring description show as follow:

DB9 Pin Functions
1 NC（No connect）
2 NC
3 PROFI_B(Must be connected), Data positive
4 RTS
5 GND
6 PROFI_5V
7 NC
8 PROFI_A(Must be connected), Data negative
9 NC

3.5.3 RS232 Interface

Configuration interface, and after connecting with computer, users can modify PD-100S configuration

parameters through Hyper Terminal. Specific configuration steps, see Chapter 6.

3.5.4 Power Interface

Pin Function
1 GND
2 NC, no connection
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3 24V+, Positive 24V DC

Note: This interface of the V +, GND and DeviceNet interface in the V +, GND are internally connected. So an

external power supply only one interface can be connect, can not simultaneously connected to the two interface power

supply.
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4 Run
The data converter of PD-100S between DeviceNet and PROFIBUS can be made by “mapping”. There are two

data buffers in gateway, one is PROFIBUS Network Input Buffer, and the other is PROFIBUS Network output buffer.

DeviceNet writes data which has been read from devices into Network Input Buffer, and write data to DeviceNet

device through POLL I/O write commands from Network Output Buffer.

PD-100S not only act as a DeviceNet slave node, as well as a PROFIBUS-DP slave node, and need to take up a

node address.

Input Buffer Output Buffer
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5 QuickApplication Guide
Use the following steps to apply your PD-100S:

1) According to the configuration steps configure gateway, refer to chapter 6.

2) Setting PROFIBUS-DP address through the rotary switch of the gateway, refer to chapter 3.3.

3) Setting DeviceNet address and baud rate through the DIP switch under of the gateway, refer to chapter 3.3.

4) Correctly wiring in accordance with the instruction, refer to chapter3.5.

5) Install EDS file to DeviceNet configuration software (such as RSNetWorx), and configure DeviceNet

Network. The user can configure the DeviceNet scan commands and the data mapping from DeviceNet to

PROFIBUS-DP, refer to chapter7.

6) Install GSD file to PROFIBUS-DP configuration software (such as STEP 7), and map the PROFIBUS-DP

input-output to the PLC or other devices, refer to chapter 8.
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6 Gateway Configuration Instructions
Users can connect the gateway to PC through Gateway’s RS232 interface and 232 direct cable (Together with

the PD-100S to the client, one terminal end is 3-pin connector, and the other end is the DB9 connector) and configure

the gateway through Hyper Terminal. Take all DIP switches of the gateway to off, and the value of the rotary

code switches to 0, re-power the gateway and the gateway enter the configuration mode.

6.1 Setting Hyper Terminal
You can find the Hyper-Terminal in “Windows — Start — All programs — Accessories — Communications —

Hyper Terminal”. Select the port being connected to PD-100S, and the port settings are shown as follows:

9600, 8, None, 1 None.

6.2 Main Menu
After setting the Hyper-Terminal, power on the module, STA always Green, PBF always Red, MS always Green,

and the main menu will be displayed. As the following picture shows:
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Item (1): Set input and output bytes length of PROFIBUS-DP and DeviceNet. 32, 96, 48, 112, 72, 160, 192,

224bytes can be selected and the default is 48 bytes;

Item (2): Open or close the DeviceNet network status word. When you select Open, the last two bytes of the

network input data is the status word. You can select “Clear Data” or “Keep Last Data” the input data when a network

breaks.

Item (3): Set data exchange mode, No swapping, Two bytes swapping, and Four bytes swapping;

Item (4): Set operating mode, Compatible mode (Support PD-100SV31) and Normal mode(PD-100SV41).

Item (5): Display the current settings. Input and output bytes length of PROFIBUS-DP and DeviceNet, Use the

status word or not, Data exchange mode and product serial number, hardware version, firmware version;

Item (6): Update the firmware.

6.2.1 Show the Current Configuration

Select 5 in the configuration main page, and it will show all current configuration. For the first time into the

Hyper-Terminal configuration page, can view the configuration by selecting the option to determine what needs to be

modified:

6.2.2 Set Input and Output Bytes

Select 1 in the configuration main page and it will show the current number of input and output bytes and other

options. As shown below:
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When you need to change the settings, you can set input and output bytes through inserting the different number

of bytes. The figure chooses 3, namely 48-byte input and output.

6.2.3 Set Status Word

Select 2 in the configuration main page and it will show status word set options and current configurations. As

shown below:
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When you need to change the settings, you can follow the prompts, enter “y” for using status word, that is, the

last two bytes of input data show the network status of another network. Enter "n" to disable it.

When you enter "y”, it will pop-up "clear or not" option:

Option 1: Clear Data;

Option 2: Keep Last Data.

Note: When choose not to use status words, input data of breaking network will be cleared forcibly.

As shown below:
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6.2.4 Setting Data Exchange Methods

Selected 3 in the configuration main page, shows data exchange options and all current configurations. As shown

below:

Option 1: No swapping;

Option 2: Two bytes swapping;

Option 3: Four bytes swapping;

Configuration options as shown below:
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6.2.5 Setting Operation Modes

Selected 4 in the configuration main page, shows operation mode options and current configurations.

Option 1: Compatible mode (Support PD-100SV31 and user can use EDS file and GSD file of PD-100SV31)

Option 2: Normal mode (PD-100SV41)

Configuration options as shown below:
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When select “2”, it select “Normal mode”. As the following picture shows:
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6.2.6 Update Firmware

Select 5 in the configuration main page, it shows "Press y to enter the mode to update the firmware. Press any

other key to exit".

At this moment, enter "y" to enter the updating firmware mode, enter the other value can exit updating firmware.

Enter "y", it will show "Please close the serial port and start the firmware upgrading program", show as below:

Follow the prompts, after disconnecting with the Hyper Terminal, the updating firmware operation can be

carried out.

Note 1: After disconnecting with the Hyper Terminal and before updating the firmware, the keyboard can not be

entered any values to prevent these values affect the product firmware via the serial port.

Note 2: Number of input and output bytes of PROFIBUS-DP and DeviceNet and data swapping methods which

is set in Hyper Terminal can be also configured in the fieldbus network, specifically in the chapter 7and 8.

Note 3: To exit configuration mode, you just need to set dial switches and rotary switches to a non-zero value,

re-power the gateway and the gateway go into the normal operating state.
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7 DeviceNet Network Configuration Instructions
After register the PD100S.EDS in the CD-ROM to DeviceNet configuration software, users can configure via the

software.

7.1 EDS Register

EDS（Electronic Data Sheet）is comprehensive description which supports DeviceNet network function. It equals

to equipment’s driver of Windows. Users need install EDS files to DeviceNet network configuration software, such as

RSNetWorx and so on, and then the configuration can be going on through network configuration software.

Here we take Rockwell's RSNetWorx for example (edition 4.12.0), and explain how to install. For further details,

please refer to the network configuration software instructions.

Step1: Create a new network configuration profile

Step2: Select EDS operation guide, select “Tools” and then “EDS-Wizard”, you will see that:



U ser M anu a l 

P D 100S  

www.sibotech.net
21

Step3: Select “NEXT”, as follow:

Step4: Install gateway PD-100S

Shown as above, select “Register an EDS file”, as follow:

Please register PD-100S.EDS file we provided, according to the place where you save EDS file, and select the

file.
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Step 5：Select the file registering to choose

Click “NEXT” :
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Step 6: Select the icon.

Following network configuration software will prompt you the equipment category in equipment storehouse, you

may choose icon in this process.
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Here, the device has successfully registered to the icon library location of configuration software’s equipment

storehouse.

Then, you should connect gateway PD-100S to DeviceNet network, click “SCAN” button of RSNetWorx , or

select “Network-Online” in menu bar, your gateway will be scanned by system and identified exactly.

7.2 DeviceNet Parameters Information
You can configurate devices online or offline. For details, please refer RSNetWorx manual.

The following configuration demonstrates are in "Offline" status.

Registration location of
gateway EDS
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From the device catalog, you can find the "DeviceNet / PROFIBUS-DP Gateway" in "Vendor" (manufacturing

number) and "Shanghai Sibotech Automation Co. Ltd." directory, and drag it into the editing area, select the device

address matching with the actual address, then double-click the device, you will see the following screen:

You can also modify the device address. Click the "Parameter", then you can enter the parameter interface:
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This is DeviceNet network configuration parameters interface of a device in RSNetWorx (PD-100S default

configuration).

Note: If you modify number of I/O bytes in the interface, you need re-power the gateway to take the

modification effect.

The first parameter is "PROFIBUS status", it shows the current PROFIBUS-DP state;

The second parameter is the "I / O bytes", it shows the DeviceNet input and output bytes, 32, 96, 48, 112, 72, 160,

192, 224 bytes are optional, and the default is 48 bytes. You need to restart the gateway after re-setting the parameter

and downloading.

Users can accord the actual needs of bytes to choose the length of input and output bytes. After modifying the
parameter; users need to pay attention to configure the scan list in 1756-DNB module (DeviceNet Master Module),

which is the same with the parameter "I / O bytes".

Note: If you modify DeviceNet input and output bytes here, you have to modify the PROFIBUS-DP input and

output bytes in PROFIBUS-DP configuration interface (PROFIBUS-DP master configuration software)! If you set the

parameter is 48/48 bytes here, you must choose "48 byte input 48 byte output" at the PROFIBUS-DP side.

The third parameter is "Swapping Data", it shows whether to swap sequencing of the two networks when

exchange data, you can select "No swapping" (not swap), "Two bytes swapping" (double-byte swap) and "Four bytes
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swapping" (4 bytes swap). After downloading the parameters, with immediate effect, power-down can be saved. The

default is double-byte swap.

Note: If the mapping data is multi-byte variable, which being transmitted by PROFIBUS-DP is high-byte first,

while being transmitted by DeviceNet is low-byte first, you need exchange the sequence of bytes. Some devices, such

as PLC of GE which has data swapping function. Users can turn on this function according to their needs.

PD-100S also has data swapping function; you can choose "No swapping", "Two bytes swapping" or "Four bytes

swapping".

For example: Select the “Two bytes swapping”

DeviceNet output:

1 2 ... 3 4

2 1 ... 4 3

Input data of PROFIBUS-DP.

For example: Select the “Four bytes swapping”

DeviceNet side output:

1 2 3 4 5 6 7 8 ...

4 3 2 1 8 7 6 5 ...

Input data of PROFIBUS-DP.

Note: If the mapping data is multi-byte variable, which being transmitted by PROFIBUS-DP is high-byte first,

while being transmitted by DeviceNet is low-byte first. This is determined by protocol. Users may need to exchange

data sequence.

Note: When the fourth parameter is “Using status word”, the last two bytes of the input data is the status word.

The last two bytes do not exchange sequence.

The fourth parameter is "Using Status Word", whether to use the status word or not: "Yes" shows using the status

word, "No” shows not using the status word. The default is "No”.

The fifth parameter is the "Clear Data", whether to clear input-data of breaking network or not: "Clear Data"

shows that it will clear the input-data of breaking network, "Keep Last Data" shows that it will not clear the input-data

of breaking network. The default is "Clear Data".
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Note: When the fourth parameter is "No", the fifth parameter is forced to "Clear Data”, which is clearing

input-data of breaking network. At this point, if the choice is "Keep Last Data", download and re-upload, the

parameter is still "Clear Data".

7.3 Configure PLC’s I/O Scan List
This section briefly describes how to configure scanning parameters list of RSLogix5000 +1756 / DNB through

RSNetWorx.

PLC platform: Rockwell’s ControlLogix5555

DeviceNet interface card: 1756DNB

Configuration software: RSNetWorx

Step one: Open the parameters page of 1756DNB and go into the "Scan list" tab.

Step two: In this interface, select the device being added to the scanning list, then click the arrow button, and

then you can see:

Click
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Device is in the scan list of 1756-DNB DeviceNet Master.

If you know how to configure the DeviceNet, you can click on the "Edit I / O Parameters ..." and modify

parameters, or click the confirmation directly, and add all the devices to the scan list.

After clicking the "Edit the I/O Parameters..." , you will see the diagram below, users can set the I/O data input

and output mode: Polling, Cyclic, Change of state and so on. Users can also select the input / output bytes.

Note: The number of input and output bytes is a key! PLC / DeviceNet master will check input and output bytes

here with the actual response of the device when establish a connection. If the number of bytes is not the same, the

DeviceNet I / O connectivity can not be established, it can not be input and output.
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Step three: Confirm input and output mapping.

Users can see Input and Output Properties page; here is the settings on how DeviceNet I / O information of

device be associated with 1756DNB memory. Generally use the default settings (Auto-map).
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Step Four: Download the appropriate scan list to 1756DNB according to the prompts.

Step Five: Preparing corresponding program, download it to ControlLogix, then change the PLC state to run, if the

be in the programming status, PLC take DeviceNet I / O scanning, can not output data (IDLE), but only can input

data.

Note: When 1756DNB is in developing PLC program, you need to set a run control bit of 1756DNB to 1.If the

module's position in the rack is 1, the bit is Local: 1: O.CommandRegister.Run.

Ladder Example:
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7.4 Select Online Path
From offline to online, users need to select the path.

According to actual configuration options, users can select the path, the next map is using serial port (DF1) .
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Users have any further questions, please reference RSNetWorx user manual.
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8 PROFIBUS-DPNetwork Configuration
Instruction

The following content explains how to use STEP7 to set PD-100S.

First, copy *.gsd file to the following path：Step7\S7data\gsd\

1. Open SIMATIC Manager :

2. Click File->New, create a new file:
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3. Insert->Station->SIMATIC 300 Station:

Open S7 PLC hardware configuration: SIMATIC 300(1) ->Hardware, double-click:



U ser M anu a l 

P D 100S  

www.sibotech.net
36

4. Click Options-> Install GSD File, and install GSD of PD-100S:

Copy the GSD file in the relevant directory, select and register, you can find your registered device in the

hardware configuration interface, the right the window of the hardware configuration interface/ PROFIBUS DP /

Additional Field Devices/Converter/PD-100S, as shown as below:
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5. Set PLC rack, double-click “Hardware Catalog\SIMATIC 300\RACK-300\Rail”:

6. Set CPU module, choose the corresponding device types and the occupied slots;



U ser M anu a l 

P D 100S  

www.sibotech.net
38

7. Create PROFIBUS-DP network, set PROFIBUS-DP: New->Network settings, choose “DP”, choose a kind of

baudrate as 187.5Kbps, then click “OK”. Double-click it:

8. Choose address of PROFIBUS Master station:
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9. Configure PD-100S to PROFIBUS Network, and map the I/O module to S7-300 or other controller’s memory.

Operation include two steps. The first step is moving PD-100S to the left and up area, (PROFIBUS-DP bus), the

mouse will change sharp, it means you can move it in. The second step is moving data to left and down data mapping

table, (PLC memory).

Note: Number of PD-100S can be 32-byte input and output, 96-byte input and output, 48-byte input and output and

112-byte input and output. If the gateway is configured to 48 bytes input / output in Hyper Terminal or DeviceNet

configuration interface, you need take "48 Byte In, 48 Byte Out" into the data mapping table. If you drag the data

block does not match the configuration of the gateway, PROFIBUS-DP connection can not be established.

The factory configuration of number of bytes is "48 Byte In, 48 Byte Out".

Note: Slave station’s address should be the same with the setting of module’s dial switches!

10. As shown above, right-click input and output mapping of the slot, set the relevant property, as shown below:

Move the data
block to the
left and down
table.
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You can set input and output mapping area start address in the page. When the setting is “32 bytes input and

output”, the consistent is "Total length".

11. Compile and download the configuration to the PLC.
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9 How Step7 read and write Gateway Data
Data blocks which use “Total Length” as “consistent” are shown as follow:

2 Words Input Consistent

4 Words Input Consistent

8 Words Input Consistent

16 Words Input Consistent

2 Words Output Consistent

4 Words Out put Consistent

8 Words Out put Consistent

16 Words Out put Consistent

In the Step7 program, you need use SFC15 (packaged sent) send data and use SFC14 (packaged receiver) receive

data.

SFC14

SFC15

Data blocks which use “Words” as “consistent”are shown as follow:
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In Step7 program, you can use “MOVE” instruction read and write data.
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10 Installation
10.1 Mechanical Size

Size: 40mm (Width) ×125mm (Height) ×110mm (Depth)

10.2 Installation
35mm DIN rail
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